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Disclaimer
The network plan generated by the WMS planning tool uses a predictive RF model. This information is an 
estimate only of the amount, configuration, and placement of WLAN 2300 equipment and is intended to 
approximate project cost projections. 

A Wireless LAN site survey service captures actual RF data to accurately model RF environments and is still 
the best method to determine correct location of APs, and therefore installation locations of cabling. A WMS 
network plan is an approximation only and does not substitute for a Wireless LAN site survey.
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Regulatory Information

The FCC mandated new regulatory standards for Dynamic Frequency Selection in the 5.25 - 5.35 GHz and 
5.470 - 5.725 GHz bands that went into effect on July 20, 2007. Nortel Networks introduced a new access 
point, the AP 2330B, that meets these new regulatory standards by disabling operation, via software, on 
channels 52, 56, 60 and 64 in the 5.25 - 5.35 GHz band. 

WSS Release 5.0.11.4 and WMS Release 5.0.11.3 and later versions of these software releases support these 
models when using the US and Canada country codes.
Nortel WLAN Management System 2300 Series Release Notes for Release 5.0.14.2
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How to get help

This section explains how to get help for Nortel products and services.

Getting help from the Nortel web site

The best way to get technical support for Nortel products is from the Nortel Technical 
Support web site:

http://www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and tools to address 
issues with Nortel products. More specifically, the site enables you to:

download software, documentation, and product bulletins

search the Technical Support web site and the Nortel Knowledge Base for answers to 
technical issues

sign up for automatic notification of new software and documentation for Nortel 
equipment

open and manage technical support cases

Getting help over the phone from a Nortel solutions center

If you do not find the information you require on the Nortel Technical Support web site, and 
you have a Nortel support contract, you can also receive help over the phone from a Nortel 
Solutions Center. 

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following web site to obtain the phone number for your 
region:

http://www.nortel.com/callus
Nortel WLAN Management System 2300 Series Release Notes for Release 5.0.14.2
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Getting help from a specialist by using an express routing code 

To access some Nortel Technical Solutions Centers, you can use an Express Routing Code 
(ERC) to quickly route your call to a specialist in your Nortel product or service. To locate 
the ERC for your product or service, go to:

http://www.nortel.com/erc

Getting help through a Nortel distributor or reseller 

If you purchased a service contract for your Nortel product from a distributor or authorized 
reseller, contact the technical support staff for that distributor or reseller.
NN47250-401 (320667-H Version 01.04)
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What's new in WMS version 5.0.14.2

Release 5.0.14.2 adds support for resolution of several Release 5.0 known issues (go to section—“Issues 
resolved since WMS version 5.0.13.1” (page 13) for details. 

WMS license key activation
The planning and monitoring service features of WMS are licensed and require installation of license keys. 
Support for 50, 250, unlimited APs, and Planning Tool are activated using License Activation Keys.

A License Certificate is used to provide a single software license and its associated License Activation Key. 
The activation of the Planning feature and or the number of managed Access Points for your Nortel WLAN 
Management Software depends on the purchased software features.

To activate support or add additional functionality, you must obtain a License Activation Key from Nortel, and 
load the License Activation Key into the original host computer. To obtain the License Activation Key, follow 
the instructions on the License Certificate provided with the WMS Software Kit by Nortel.

When the proper License Activation Key is obtained, follow these instructions to enable the 
WMS functionality:

1 Load the WMS Application into the host computer. (Note: Ensure the software is loaded into the host 
computer that is specified in the License Key file.

2 Start WMS Application.

3 When the License Information dialog box appears, go to step 4. 
If the License Information dialog box does not appear, click Cancel to close the WMS Services 
Connection wizard, then select Help > Licensing from the menu bar. The License Information dialog box 
appears.

Note.  Refer to Release Notes for Release 5.0 for compete listing of new content added to 
Release 5.0.
NN47250-401 (320667-H Version 01.04)
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Figure 1:  License Information dialog box

4 Enter the authorization code and press Enter. 

A single authorization code activates all the requested application software.

5 Your Nortel WMS application is now active. Note: For technical issues, please contact Nortel Enterprise 
Technical Support (NETS). See also “How to get help” (page 7).

Version compatibility

• This version of WMS has been verified against WSS Software Version 5.0.14.2. 

• Network plans created with WMS 5.0.8.1 are compatible with this version of WMS. If you want to use 
network plans created with previous versions of WMS, make sure the option to delete the network plans 
directory is not checked when you uninstall. 

After you install the new software, WMS asks whether the old network plans are to be sent to the server 
(if you want to keep them) or deleted. If multiple clients are using the same server, then the old network 
plans need to be copied only once. Nortel recommends that you archive the xml/db directory before you 
delete any old plans.

• If you are installing for the first time, you will need to install and activate licenses before using WMS. If 
you are upgrading from a previous licensed version, you do not need to reinstall your licences. (See 
“WMS license key activation” (page 10).)

• If you are upgrading from a version earlier than 4.0, Nortel recommends that you upgrade to 4.0 first, 
then upgrade from 4.0 to 5.0. 
Nortel WLAN Management System 2300 Series Release Notes for Release 5.0.14.2
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Supported platforms

• Microsoft Windows Server 2003, Microsoft Windows XP with Service Pack 1 or higher, or Microsoft 
Windows 2000 with Service Pack 4 

• SUSE Linux 9.1 and Red Hat WS 3  

VoIP devices vendor support
These are the Nortel supported options:

SpectraLink—Non-WMM SVP devices

Vocera—Non-WMM Vocera devices

Upgrading from WMS version 4.0, 4.1 or 5.0.8.1

You can install the new version of WMS on top of the previously installed one. You do not need to uninstall the 
previous version.

If you are upgrading from WMS Version 4.0 or 4.1 and you have network plans created or saved in the version 
you are upgrading from, Nortel recommends that you archive the config-db directory (if 4.1 or 4.0) before you 
install the upgrade.

To install the upgrade:

1 Make an archive copy of the config-db directory. 

2 Run install.exe (Windows) or install.bin (Linux).

3 The first time you run WMS, if you upgraded from 4.0, it might ask you what to do with the old network 
plans.

If WMS Version 5.0 has already been installed on another client, and the option to copy the network 
plans to the server was selected, then do not select the option to copy the plans to the server. (See 
“Unable to switch network plans.” (page 24).)

Likewise, do not select the option to copy the plans to the server, if the plans have already been 
copied to the server manually.

Note.  You must use the English version of the operating system you select. Operating 
system versions in other languages are not supported with WMS.

Note.  See “Operating system related issues” (page 29) for important information about 
installing and running WMS on the platforms listed above.
NN47250-401 (320667-H Version 01.04)
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If this is the first installation of WMS Version 5.0, then select the option to copy the plans to the 
server.

Downgrading to a previous WMS version

If you need to downgrade from a WMS 5.0.x version to a previous 5.0.x version, use the following procedure:

1 Back up the network plans, by copying the config-db directory to a location that is not in the WMS 
installation path.

2 Uninstall the current WMS installation. Select to delete all but the license and the network plans.

3 Install the earlier WMS software version.

4 After installation, copy the folders in the backed up config-db directory to the one that is created by the 
installation in step 3.

When you start the downgrade version of WMS, it opens the Default network plan. 

If you need to downgrade the WSSs managed by WMS, you can do so before or after the WMS downgrade.  

Issues resolved since WMS version 5.0.13.1

An alarm notification through email could cause the WMS server to cease responding when the mail 
server fails to send an SMTP response. (44539)

Using WMS to distribute certificates to WSS causes unexpected behavior with the WMS client. 
(43820)

Changing radio profiles from one name to another in a wireless service profile policy does not work as 
expected when applied to devices. The device would be configured with both profiles. (42691)

Note.  WMS 4.1 backup files can not be used with WMS 5.0.x.

Note.  Nortel recommends that you do not downgrade to previous WMS versions. 
Database files saved in WMS Version 5.0 cannot be used in earlier WMS Versions. In 
addition, WSS Software features that are new in WSS Software Version 5.0 are not 
supported in previous versions of WMS.
Nortel WLAN Management System 2300 Series Release Notes for Release 5.0.14.2
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Issues resolved since WMS version 5.0.11.3

WMS showed incorrect session details. (41699, 41582)

Client statistics panel does not collect information on clients who roam. (41551)

Certain URLs that contain escape characters (in the form %HexHex) are not handled by Web Portal 
and may prevent the client from accessing the login page or loss of Web connectivity. Such URLs have 
been known to be generated by applications like Windows Live Messenger. It is recommended that 
clients do not run this type of application before performing Web Authentication. (41477)

When creating a DNS server in WMS you must define if it is the primary or secondary DNSserver. By 
default WMS always suggests secondary while Primary is selectable from drop-down menu. (41249)

On the Reboot WSS/AP page, it was difficult to identify an WSS that can reboot a given DAP as all 
DAPs that were configured on multiple WSS switches. (40365)

If 'RF & Traffic Trending' is changed from disabled to enabled, WMS did not appear update the 
display of 'RF Neighborhood' for an APs radio until the WMS service was restarted. (40364)

Various issues that improve the ability of WMS to address large scale deployments. (39917, 39861, 
39860, 39859)

You can no longer create hidden coverage areas in floor plans. (39726)

When creating a policy that applied to VLAN, Spanning Trees and Port Groups, and then creating the 
associated VLAN, WMS did not display the Port Groups. (39654)
NN47250-401 (320667-H Version 01.04)
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Issues resolved since WMS Version 5.0.8.1

When the Alarms Panel was open, memory usage increased and caused WMS to become 
unresponsive. (37995, 35474)

When installing the Linux version of WMS software, the Client option was missing from the 
installation screen. (37986)

Occasionally in WMS, you could not save backup files. (37845)

Wording for the Autotune Wizard was misleading and confusing. (37829)

Incorrect session displayed for an WSS on the network. (37559)

The error message that occurred when a corrupted plan or monitoring history was displayed was 
unclear and ambiguous. (37080)

Lowered default severity level for several critical alarms to major or minor. This improves alarm 
usability by only making the most important service-affecting alarms critical.(36693)

Using a “&” character in a DAP name causes the reporting to fail. (36655)

Removed duplicate alarm that states "DAP with serial number (x) is not reporting a status" when a 
AP/DAP is down. Only one alarm is displayed now.(36534)

WMS was incorrectly marking WSS & APs as down and creating critical alarms due to incorrect 
flapping detection. (36098)

Clicking "print" from the "modify user" dialog now prints the plaintext (decrypted) password 
instead of the ciphertext.(35694)

Pressing the ESC (escape) key will now cancel or close the active dialog box or wizard. (34274)

The floor plan vanishes from Monitor Floor Viewer. (33739)

Solaris: It was not possible to start a browser to activate the Web interface to WMS Services. (30234)

When a client roamed, the reported location was inaccurate. (29795)

Open access rules folder does not appear for an WSS switch that was downgraded from release 5.0 to 
4.0 (29790)

MacOS: WMS licenses were becoming invalid after the host running WMS Services is restarted. 
(29637)

MacOS: WMS services must be started manually. (28305)
Nortel WLAN Management System 2300 Series Release Notes for Release 5.0.14.2
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Issues resolved in WMS version 5.0 

Changes to radio-profile settings were not synchronized across all redundant APs. (31503)
Description   Starting in this release, when a user changes the radio profile selection on one AP, WMS 
attempts to change the radio profile on all of its redundant connections, but if that radio profile does not exist 
on a redundant AP, it will be left alone (in some cases, this means that the radio-profile will be set to default).

MAC users disappeared from policy. (32072)
Description   After creating a Web-based AAA policy that included a series of MAC addresses, then 
deploying the policy to a WSS, if you then restarted WMS, the specified MAC addresses no longer appeared in 
WMS, but were visible in the configuration on the WSS.

The “no auto-tune data available” message returned by the Disable Auto-Tune wizard was misleading. 
(32807)

Description   When running the Disable Auto-Tune wizard against a WSS with configured DAPs not booted 
off the WSS (for example, low bias) the progress dialog displays “no auto-tune data available” for each 
configured DAP not actually booted from the WSS, which could lead users to think there is a problem when 
none exists.

Attempting to restore backup files larger than 25 Mb caused error messages to be displayed. (33461)

A network plan that included a floor layout with null characters in its layer names could not be 
imported into WMS. (33935, 33241)

Creating an SNMP Notification target caused an error to be displayed. (34101)

Linux: HTML generated in WMS reports incorrectly used uppercase letters to refer to .jpg files that 
had filenames with all lowercase letters. (34125)

Java errors when starting Web Client. (34138)
Description   After installing the Web Client on a client machine, attempting to launch the Web Client 
displayed a message indicating certain files could not be located. WMS was looking for these files in the 
location they would be on the WMS server, but they would not necessarily be in that location on the client 
machine.

A large number of DeviceChange events being unnecessarily generated by the server caused WMS to 
become unresponsive. (34151)

It was not possible to launch the WMS Web client because the WMS .jar file and third-party .jar files 
were signed by different certificates. (34196)

Possible memory leak caused WMS services to be non-responsive. (34349)

When WMS was resolving verification rules, and a “Modo member is missing”, verification message 
was displayed, clicking “Remove Member”, caused WMS to crash. (34408)

The dot1X trace function incorrectly generated an error message due to an empty MAC address, and 
enabling traces using WMS did not cause them to be listed as local changes. (34418)
NN47250-401 (320667-H Version 01.04)
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After creating one Distributed AP from the Alarms panel, an error message was displayed when 
attempting to create a second Distributed AP. (34446)

After making a configuration change in a network plan, the WMS screen constantly “refreshed”, 
slowing down performance. (34718)

Filtering and sorting alerts for different areas and severities caused WMS to crash. (34752, 34455)

Deploying access rules from WMS to a WSS did not create them on the switch, and deleted access 
rules that were already on the switch. (34778)

An exception occurred when an access rule was created in WMS, an access rule was created on a WSS 
using the CLI, and then the network change was accepted by WMS. (29415)

WMS clients froze when multiple clients requested information at the same time. (29851)
Description   When two (or more) WMS clients requested information from the WMS services host at the 
same time, one client retrieved the information, while the other client(s) waited. While waiting, the other 
client(s) were unable to do anything until the first client was finished with its request.

Polling devices immediately after startup made it difficult to connect to the WMS services host. 
(29854)

Description   In a network plan with a large number (greater than 700) of WSSs, after WMS services finished 
starting, it attempted to poll all of the WSSs at the same time, causing high CPU usage and making it difficult 
to connect using the Web interface or a WMS client. In addition, polling all of the devices at once consumed 
all of the I/O threads, making it impossible for a second WMS client to connect. WMS now waits until the 
Web server and all services have been initialized before polling devices in the network plan.

Local change resulted in Network change that could not be accepted or undone. (31067)
Description   This issue occurred in the following scenario:

1 On a WSS, SNMP is enabled with the security type set to Encrypted and the protocol set to USM 
(SNMPv3).

2 The WSS is uploaded into WMS.

3 On the WSS, the command to disable USM is entered at the CLI.

4 The resulting network change is accepted in WMS.

5 On the WSS, the configuration is saved, and the WSS is rebooted.

6 After the WSS is rebooted, WMS indicates a network change that USM has been changed from enabled 
to disabled. However, this change cannot be accepted or undone; clicking Accept or Undo has no effect.
Nortel WLAN Management System 2300 Series Release Notes for Release 5.0.14.2
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In the Tasks View dialog, the device name disappeared from the list of entries when sorted. (31374)
Description   If you displayed information in the Tasks View dialog (by selecting the Devices icon, then the 
View Operation Log task) the entries are initially sorted according to the Device column. If you then sorted the 
entries according to a different column, the names of the devices disappeared from the sorted list, making it 
impossible to sort the entries by device name again.

Creating a policy caused Web-based AAA related settings for a WSS to be overwritten. (31402)

If you reordered authentication server groups, it did not create a local change that could be deployed. 
(31421)

In RF planning, the coverage for APs using omnidirectional antennas was being shown as directional. 
(31671, 31033)

The RF Monitor function did not display the correct list of WSSs configured for AP redundancy. 
(26858)

The RF Monitor function did not display user-defined names for DAPs. (27399)

Applied changes for ACLs in policies only took effect when the ACLs were deleted or created, but not 
when the ACLs were modified. (29416)

Description   When you created an ACL using a policy, then applied the policy to a WSS, the ACL was 
correctly shown in the WSS’s configuration. However, if you subsequently modified the ACL and deployed 
the changes to the WSS, WMS indicated that the changes deployed correctly, but the ACL changes did not 
actually appear in the WSS’s configuration.

A policy containing Wireless Service Profiles and Radio Profiles could not be applied. (29659)

WMS crashed when saving RF obstacle data for a floor took longer than 15 minutes (29674)

Selecting a single WSS created by the RF Planning function and pressing Ctrl+D did not allow you to 
delete the WSS. (29676)

In a Network Plan consisting of multiple floors, the WMS Compute and Place function placed APs on 
the incorrect floor. (29679)

When configuring a Web Portal service profile, in the Authentication Server(s) dialog, the LOCAL 
option was not available in the Available RADIUS Server Groups list. (29685)

Message “Error: The server is currently unavailable due to critical errors encountered during 
startup.” displayed when starting WMS. (29762)
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Description   Changing the model type for a switch in a network plan, then restarting the machine running 
WMS Services, resulted in an error message when you connected to the machine running WMS Services.

Deploying changes to an WSS caused the WSS to produce a core file. (29773)

Creating a Voice service on an Open Access SSID using the Wizard did not create the required Open 
Network Access Rule. (29785)

RF Detection resolution showed a blank screen. (29787)
Description   If you added a MAC address to both the Rogue list and the Ignore list, an error message was 
displayed (correctly), but when you tried to view the details of the error message under the Verification tab, a 
blank screen was displayed.

Selecting a large number of WSSs (more than 10) and then accepting network changes for these WSSs 
took a long time. (29846)

Using certain IP address ranges generated Verification warnings. (29847)
Description   If you tried to configure devices in WMS to use Class A IP addresses in a range higher than 
126.0.0.0 (191.0.0.0 for Class B, 223.0.0.0 for Class C), WMS indicated that the IP address was not in any 
standard class (A, B, or C).

Device list data reverts to default sorting order after reviewing changes. (29848)
Description   On the Devices Tab, if you clicked on a data column to sort the list of devices according to the 
data in that column, then clicked on Review to review local or network changes, when you closed the Review 
Changes dialog, the data in the device list reverted to the default sorting order.

WMS displayed a Warning message indicating an invalid slot number (0) was detected for an AP. 
(30331)

After clicking Objects to Place option, an Internal Application Error message was displayed. (30344)

The AP Redundancy dialog did not use max. configured AP count. (30553)
Description   The Select Bias and Device(s) for Redundancy dialog, used in the Setup AP Redundancy 
wizard, displayed the number of APs that could be booted by the switch, instead of the maximum that could be 
configured on the switch.

New AutoCAD formats were not supported by WMS, and opening a floor plan with an unsupported 
AutoCAD format could cause an exception. (22542)

Attempting to copy and paste a service profile from one WSS to another WSS of a different model 
caused a Java exception. (25128)
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Verification options did not allow changing the Default network plan's country code to match an 
uploadedWSS’s, if the WSS’s country code was not US. (27048) 

WMS did not check for available space on a WSS’s nonvolatile storage before attempting to download 
an image to the switch. (27521)

If you selected the Use System IP Address checkbox in the RADIUS configuration section, WMS did 
not see it as an available change. (28824)

Configuration parameters of an unmanaged switch that had the same configuration as a managed 
switch were listed as local configuration changes. (29121)

Access Control List (ACL) Setup Panel disappears when returning to setup panel screen from Device 
panel (33760)

Workaround   Exit the ACL screen by selecting a feature on the Organizer panel (VLANs, QoS, etc.) and then 
return to the ACL screen.

WMS java client running on Windows XP or Windows Server 2003 reports an internal error of 
“failed connection to SQL database” (33890)

WMS Web client incorrectly shows switch connection settings as “WSS Connection Settings” it should 
show “WSS Connection Settings”. (33958)

Known issues

Linux: Default browser is Firefox, which is not included with SuSE. (30491)
Description   On SuSE, the default browser executable is Firefox. However, the Firefox browser is not 
included with the SuSE distribution; only the Konqueror browser is. The Konqueror browser is not supported 
by WMS. 

Workaround   Install a different browser for accessing WMS online help. Preferred browsers for Linux are 
Firefox, Opera, Mozilla, and Netscape.

WMS does not support 64-bit operating systems. (36335)
Description   This release of WMS does not support 64-bit operating systems, such as Windows XP 
Professional x64 Edition, due to memory issues that may arise when the WMS server is managing a large 
number of switches and APs.

Workaround   Use a 32-bit operating system for your WMS installation.

On Windows 2000, the default browser executable in WMS does not launch the browser. (38894)
Workaround   You can manually select a browser executable at Tools -> Preferences -> Tools -> Broswer 
Executable. For example, to use Internet Explorer, you can specify C:\Program Files\Internet 
Explorer\IEXPLORE.EXE as the executable.

A non-administrative user cannot run WMS. (12155)
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Description   WMS generates an exception if a user does not have administrative privileges on the WMS host. 
This issue involves the Java Virtual Machine (JVM) that is being used by WMS and should be resolved with a 
future release of JVM.

Workaround   To use WMS, users must belong to a “Power Users” group or be added to the administrators 
group in the Windows operating system.

When the VLAN name is composed entirely of numbers in ACL VLAN mappings imported from the 
CLI, WMS assumes that the VLAN name is a VLAN ID. (12682)

Description   A VLAN can be specified in the CLI by its VLAN ID or its VLAN name. When the CLI 
command is imported into WMS, the VLAN reference type is not apparent. If the VLAN reference is 
composed entirely of numbers, WMS assumes that the reference is a VLAN ID. Otherwise, WMS assumes 
that the reference is a VLAN name. 

Workaround   Do not use VLAN names that consist entirely of numbers.

Importing of a floor plan in JPEG format might fail with a color conversion exception. (14631)
Description   On rare occasions, importing a floor plan in JPEG format might fail with the following Java 
exception: 

sun.awt.image.ImageFormatException: Unsupported color conversion request. 

This exception occurs because of unusual color palette settings in the file.

Workaround   Using a JPEG editing tool, manually remove all extraneous information possible to remove the 
problematic color information. Alternatively, convert the JPEG file into a GIF file to import.

Size or location adjustments of shared coverage areas with identical dimensions might cause problems 
when you run Compute and Place. (14631)

Description   When shared 802.11a and 802.11b/g coverage areas are created, one coverage area is directly 
placed on top of the other. If you resize or move one of the coverage areas, the other coverage area is now a 
different shape or in a different location. Running Compute and Place might not work.

Workaround   Use the dimension toolbar icon to set the center and size of each coverage area to identically 
match each other.

When importing a CAD file (DWG/DXF), any lines with arrowheads will display incorrectly. (15906)
Description   When importing DXF or DWG CAD files with lines that have line ends (arrows, dots, and so on) 
the objects get imported with huge arrows at the ends of the lines.

Workaround   Use a CAD program to remove any arrowheaded lines, or modify the line’s properties to not 
display an arrowhead. Alternatively, delete the line while in the Edit Content page of the Floor wizard in 
WMS.

WMS does not support the Ctrl + drag-and-drop mouse operation. (16425)

Polling interval for client session cannot be changed. (17585)
Description   By default, WMS polls every 30 seconds for performance monitoring of a client chosen from the 
watch list. This polling interval cannot be modified.

Enabling STP on a WSS’s management VLAN causes a configuration deployment to fail. (17668)
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Description   If you use WMS to enable STP on a WSS's management VLAN, then deploy the configuration, 
the deploy fails. The failure occurs because the management interface must pass through the standard 
Listening and Learning states, which together take at least 30 seconds, before the interface can change to the 
Forwarding state. Until the interface reaches the Forwarding state, the switch cannot receive traffic, such as 
configuration deployment from WMS, on its management interface.

Workaround   If this occurs, wait 30 seconds for the interface to reach the Forwarding state, then accept the 
WSS's change in WMS.

Disabled radio on operational AP does not turn red if the AP or WSS becomes unavailable. (18330)
Description   In the Explore and Status Summary windows of the Monitor tab, the operational state of Nortel 
equipment is indicated by color, and is also indicated in the Status column of the Status Summary window. For 
example, if a WSS goes down, its icon turns red. However, if the AP or WSS for a disabled radio goes down, 
the radio does not turn red. In addition, the value in the Status column of the Status Summary window changes 
from Operational to Not Applicable. (It is normal for a disabled radio’s state to be Operational, since disabled 
radios perform RF sweeps for rogue detection.)

Workaround   This issue is cosmetic only and does not affect other information displayed for the equipment.

Daylight Savings Time or timezone changes are not automatically detected in WMS. (18422)
Description   If a Daylight Savings Time or timezone change occurs on the host machine where WMS is 
running, displayed timestamps are not automatically updated in WMS. 

This issue is actually a Java Virtual Machine (JVM) issue. The JVM does not detect date or time changes made 
at the OS level. See the following web page:

bugs.sun.com/bugdatabase/view_bug.do?bug_id=4216582

Workaround   Exit and restart WMS to place a date or time change made on the host machine that is running 
WMS into effect.

Opening a network plan that has more APs than the license allows sets all WSSs in the plan to 
unmanaged. (19841)

Description   If you open a network plan that has more APs than your license level allows, WMS deselects the 
managed option on the switches. 

Workaround   To manage the switches, remove enough APs to bring the total down to the allowed limit, then 
reselect the managed option for each switch and save the changes. (The managed option is available on the 
System & Administrative page of the WSS wizard.) Alternatively, you can upgrade your license. 

dbtools command line utility is not applicable to backing up or restoring network plans. (20416) 
Description   WMS 4.1 automatically saves backups of network plans, and enables you to configure backup 
options, create backups, and restore network plans from backups. However, the network plan backups cannot 
be managed using the dbtools command line utility. 

Workaround   To manage network plan backups, use the Backup & Restore function.

License upgrade requires restarting WMS Services. (21342)
Description   WMS Services checks license information when you start the server. 

Workaround   If you upgrade a license, do the following to place the license upgrade into effect:

1 Select File > Close to log off of WMS Services.
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2 Select File > Connect, then click Next to log back on to WMS Services.

Radio statistics for Auto DAPs are not correct. (21644)
Description   The radio statistics for DAPs that are configured by the Distributed AP profile (Auto-DAP 
profile) are not correct. However, statistics for statically configured APs (Distributed and directly attached) are 
correct.

Repeated error message when copying a notification profile without editing the name. (22759)
Description   If you select a notification profile in the Notification Profiles table and click the copy icon, then 
click OK in the Notification Profile Properties dialog without first editing the profile name to make it unique, 
WMS displays the following error message multiple times:

A Notification already exists with the same key [Trap Type] 

Workaround   Despite the repetition, the messages mean simply that you need to edit the profile name to 
make it unique. Click OK to clear the messages, then edit the profile name.

Mouse must be still during clicks when selecting multiple rows in tables. (23189) 
Description   WMS supports multiple selection of objects using the CTRL+right-click method. However, if 
you move the mouse as you are clicking, the previously selected rows are deselected. 

Workaround   To avoid this issue, make sure the mouse is not moving before you click.

Email Notification is not supported. (26684)
Description   WMS 4.0 had some email notification fields on the Network tab of the client Preferences dialog. 
These fields were not supported in WMS 4.0 or 4.1 and are not supported in WMS 4.2. The fields were still 
present in WMS 4.0 but have been removed from WMS 4.1 and later.
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Unable to switch network plans.
Description   If you try to switch to a version 3 network plan that still exists on the local client, WMS displays 
a dialog box asking you what to do with the version 3 network plans. The default is to send them to the server. 
However, this will fail if a copy already exists on the server (for example, copied there by another user). If you 
cancel this dialog box, the network plan will not be switched.

Workaround   After you copy the version 3 plans to the server, rename the config-db directory to 
config-dbold. You can now switch to the copy of the network plan on the server.

Open access rules folder does not appear for a WSS that was downgraded from release 5.0 to 4.0 
(29790)

Description   If you downgraded a WSS from version 5.0 to version 4.0, if it had an Open Access service 
profile, there was no Open Access rules folder in WMS.

Workaround   None. The open access rules were deprecated in release 4.1

When a client roamed, its reported location was inaccurate (29795)
Description   If a client roamed from its original location to a new location, the location reported by WMS 
after the client moved was inaccurate by a substantial amount. If the client did not move again, WMS was 
more accurate the next time the client was located.

Workaround   To ensure a more accurate location reading for a client that has recently roamed, wait two to 
three minutes after the client has stopped roaming to locate the client with WMS.

Network optimization option not available in WMS.
Description   The Network checkbox, which causes WMS to use RF neighborhood information imported from 
AP radios in the network when optimizing a network plan, is no longer available in the RF Neighborhood 
Source dialog (under RF Planning, Import Measurement task).

Workaround   None. Optimizing a network plan using measurements imported from AP radios in the network 
(that is, network optimization) is a deprecated feature in WMS 5.0.

WMS crashes and loses all configuration when performing backup and restore of network plan. 
(33895)

Unable to remove Third-Party APs heading from WMS Organizer panel even though the AP can be 
deleted. (33728)

The number of alarms showing in the chart view on WMS differs from the quantity of alarms shown 
in the corresponding table view. (33727)

WMS Monitor shows traffic details in negative numbers. (33702)

Switching to Monitor > Status Monitor Details on a switch listed in the network plan, but unavailable, 
caused WMS to crash. (33475)

WMS web client message: Java Runtime Environment 5.0 popup states “Java Web Start is not 
installed - download JRE5.0” This is a cosmetic error message and will be addressed in WLAN 6.0. 
(Q01540767)

WMS 4.1 backup files can not be used with WMS 5.0.x (Q01523749)
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Description   Backup files saved in WMS release 4.1 cannot be restored in WMS release 5.0.

WMS does not collect client statistics and a chart is not generated. (36613)
Description   WMS Monitor Client Details does not collect client statistics when viewing data from the WSS 
2380.

Changing rate configuration using WMS (Q01576410)
Description   When radio transmission rates for both b and g radios are changed at the same time and 
deployed to the switch through WMS the transmission rates can be corrupted through CLI output seed switch 
and some users will lose connection. If both radio transmission rates are set to default, the g radio will only 
transmit rates of 1.0 and 2.0

Workaround   Deploy only one radio at a time.

Converting Access Points to Sensors using WMS (34278)
Description   To convert a Nortel Access Point to an AirDefense Sensor using WMS.

Workaround   To convert a Nortel AP to and AirDefense Sensor, do the following:

1 In WMS, click Configuration in the Menu Bar and in the Organization Panel select the plan name (for 
example Default). In the AirDefense task panel click Create AirDefense Sensor

.
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2 In the Create AirDefense Sensor window click Next.
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3 If the AirDefense conversion image has not yet been transferred to the Nortel Wireless LAN Security 
Switch, click Select a File and select the AirDefense conversion image. Once the image has been 
specified, in the WSS List select one or more Nortel Wireless LAN Security Switches to transfer the 
image too and then click Start Transfer. The conversion image will be transferred to the Nortel Wireless 
LAN Security Switch and will be named adconvert.bin. Once the transfer is completed, a Completed 
message will be displayed in the Status field. Click Next.

4 Select one or more Nortel Access Points to convert to AirDefense Sensors. Once selected click Next.
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5 The specified Nortel Access Points will now be instructed to download the AirDefense conversion image 
their Nortel Wireless LAN Security Switch. If successful a Completed message will be displayed for 
each Nortel Access Point. Click Next.

6 You can optionally delete the Nortel Access Points configuration from the Nortel Wireless LAN Security 
Switch. Deleting the configuration will remove any AP Down alarms from being displayed in WMS as 
well as free an Access Point connection on the Nortel Wireless LAN Security Switch. Click Finish.
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Operating system related issues

Linux: Installing WMS on Linux crashes when the display permissions are not set correctly. (15344)
Description   The installation program is an X Window System application. Display permissions for your 
desktop environment need to be correctly set for the installation program to run successfully.

Workaround   Use the xhosts or xauth commands to allow the installation program to run in your desktop 
environment.

Linux: Installation might require some Linux setting changes. (25196)
Description   If you are installing WMS on a newer Linux version such as Redhat Fedora Core FC4, 
installation might not be successful and a message such as the following might be displayed.

Error: cannot restore segment prot after reloc: Permission denied

Workaround   If this occurs, you might need to change some Linux setting changes. For more information, 
see the following:

http://www.rsinc.com/services/techtip.asp?ttid=3092

http://sunsolve.sun.com/search/document.do?assetkey=1-25-83248

Linux: Online Help does not work with Konqueror browser on Linux (27225)
Description   Attempting to open WMS online help with Konqueror 3.1-12 on KDE 3.1-10 can cause an 
empty browser window to be displayed.

Workaround   Install a different browser for accessing WMS online help. Preferred browsers for Linux are 
Firefox, Opera, Mozilla, and Netscape.

Linux: Default browser is Firefox, which is not included with SuSE. (30491)
Description   On SuSE, the default browser executable for WMS is Firefox. However, the Firefox browser is 
not included with the SuSE distribution; only the Konqueror browser is. The Konqueror browser is not 
supported by WMS.

Workaround   Install a different browser for accessing WMS online help. Preferred browsers for Linux are 
Firefox, Opera, Mozilla, and Netscape.

Windows: Running WMS services on Windows XP is not recommended for network plans with more 
than 10 devices. (32095)

Description   Because of a limitation in Windows XP that allows no more than 10 half-open connections, 
running WMS services on Windows XP is not recommended if your network plan contains more than 10 
devices. If 10 devices in your network plan were unreachable or not responding, Windows XP would exceed 
its half-open connection limit, and connection attempts to reachable devices might time out as a result.

Workaround   If your network plan contains more than 10 devices, and you want to run WMS services on a 
Windows system, use a server OS, such as Windows 2000 or Windows 2003, instead of Windows XP.

In WMS local changes are available after upgrading from WSS 4.1.x to 5.0.x (32402
Description   In software release 4.1.x, the radius key is set to clear, while in 5.0.x the radius key is encrypted. 
This produces local changes after upgrading.
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Workaround   Undo the local changes after upgrading

In WMS 5.0.x for last-resort user functionality the user must deploy local changes after downgrading 
from 5.0.x to 4.1.x. (33182)

Submitting problem reports

WMS can send problem reports to the Nortel Enterprise Technical Support (NETS) team directly when it 
encounters a problem. You can also send a problem report at any time by selecting Help > Report Problem 
in WMS. 

If a problem occurs, the Internal Application Error dialog box appears.

To submit a problem report:

1 Do one of the following:

In the Internal Application Error dialog box, click Report Problem. 

Select Help > Report Problem.

The Report Problem to Nortel dialog box appears.
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2 Fill out the information in the dialog box.

Provide your name, and enter as much detail as possible about the task you were performing when the 
problem occurred. You must provide the name of your company.

3 Click Save to store the problem report on the WMS host. 

The problem report is saved as a directory with a name containing the timestamp of the problem report 
(for example, Mon-Aug-21-13-04-11-PDT-2006). This directory is located in C:\Documents and 
Settings\user_home_directory\Nortel\bugs, where user_home_directory is the home directory of the user 
that is running WMS at the time the problem report is generated. 
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